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1 Contact NECS

· Please visit our website at www.necs.com to learn about our other add-on modules, products
and services. 

· Contact our NECS Sales Department at sales@necs.com for more information. 

· Contact the Tech Support Department at tech@necs.com for assistance.

For information about current NECS software training classes use this link:
necs.com/training.php

NECS, Inc. 

322 East Main Street, Third Floor 

Branford, CT 06405

Office Hours: Monday - Friday from 8:30AM EST - 5:30PM EST

Toll Free: 800.766.6327 (NECS)   Phone: 475.221.8200   Fax: 203.208.0889

https://necs.com/index.php
mailto:sales@necs.com
mailto:tech@necs.com
https://necs.com/training.php
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2 License Agreement
NECS entrée V4 SQL and RELATED ADD-ON MODULES

SOFTWARE END USER LICENSE AGREEMENT

THIS SOFTWARE END USER LICENSE AGREEMENT (“THIS AGREEMENT”) IS A LEGAL AND BINDING
AGREEMENT BETWEEN YOUR COMPANY (LICENSEE) AND NECS, INC., A CONNECTICUT "CLASS C"
CORPORATION WITH ITS OFFICE LOCATED AT 322 EAST MAIN STREET, 3RD FLOOR, BRANFORD, CT
06405 (NECS). 

THIS AGREEMENT GIVES YOU THE RIGHT TO USE entrée V4 SQL (THE “SOFTWARE”). BY
DOWNLOADING, INSTALLING OR OTHERWISE USING THE SOFTWARE, YOU ACCEPT AND AGREE TO
BE BOUND BY ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE
TO THESE TERMS AND CONDITIONS, DO NOT DOWNLOAD, INSTALL OR OTHERWISE USE THE
SOFTWARE. 

1. Grant of License. This Agreement grants you a non-exclusive, nontransferable, non-sub licensable license
to install and use one (1) copy of the specified version of the Software to be installed on your server and
designated workstations based upon the user license count purchased. 

2. Ownership. The Software is licensed and not sold to you. This Agreement grants you only the right to use
the Software, but you do not acquire any rights, express or implied, in the Software other than those
specified in this Agreement. NECS retains all rights, title, and ownership to the Software, including all
patents, copyrights, trade secrets, and other intellectual property rights incorporated therein. The Software
is protected by copyright laws, international treaty provisions, and other intellectual property laws.
Therefore, other than as expressly set forth herein, you may not copy the Software without prior written
authorization of NECS, except that you may make one (1) copy of the Software for your back-up purposes
only. You may not edit any printed or electronic materials accompanying the Software. 

3. License Restrictions. Except as provided otherwise herein, you shall not rent, lease, sublicense, sell,
assign, loan, or otherwise transfer the Software. You shall not, and you shall not permit any third party, to
reverse engineer, decompile, or disassemble the Software. You may not remove or destroy any product
identification, copyright notices, or other proprietary markings or restrictions from the Software. You may
not modify or adapt the Software, merge the Software into another program or create derivative works based
upon the Software. You may not copy the Software onto a greater number of workstations than your
purchased user license count. 

4. Termination. This Agreement shall be effective upon installation or first use of the Software and shall
terminate (i) at the discretion of NECS, due to your failure to comply with any term of this Agreement; (ii)
failure to pay Software Maintenance fees; or (iii) upon destruction of all copies of the Software and related
materials provided to you by NECS hereunder. NECS rights and your obligations shall survive the
termination of this Agreement. 

5. Upgrades. NECS may, at its sole option, make upgrades to the Software available by general posting on a
website or by any other means or methods. Such upgrades may be made available pursuant to the terms of
this Agreement or the release of such upgrades to you may be subject to your acceptance of another
agreement. 

6. Support Services. Your license for the Software does not include any technical or other support ("Support
Services") for the Software. Support Services are provided through a separate, paid agreement known as the
"NECS Software Maintenance Agreement". Your continued use of the Software requires that you both
maintain a current Software Maintenance Agreement with NECS and that you be current on the scheduled
payments which are specified in that Agreement. Per Section 4 above, failure to comply with this
requirement can result in termination of your license to use the Software. 
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7. Limited Software Warranty. The Software, Software maintenance services and Software updates, are
provided "AS IS", without warranty of any kind, expressed or implied, including but not limited to, the
implied warranties of merchantability, or fitness for a particular purpose. NECS does not warrant that the
functions contained in this Software will be uninterrupted or error-free. The entire risk as to the quality and
performance of the Software is with the Licensee. SHOULD THE SOFTWARE PROVIDED BE DEFECTIVE,
YOU (NOT NECS) ASSUME THE ENTIRE COST OF ALL-NECESSARY SERVICING, REPAIR, OR
CORRECTION. WHILE EVERY PRECAUTION HAS BEEN TAKEN IN THE PREPARATION OF THIS
SOFTWARE, NECS ASSUMES NO RESPONSIBILITY FOR ERRORS OR OMISSIONS, OR FOR
DAMAGES RESULTING FROM ITS USE OR MISUSE. IN NO EVENT SHALL NECS BE LIABLE FOR ANY
LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGE CAUSED OR ALLEGED TO HAVE BEEN
CAUSED DIRECTLY OR INDIRECTLY BY THIS SOFTWARE. IN NO EVENT WILL NECS BE LIABLE TO
YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL
OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE
EVEN IF NECS AUTHORIZED REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY. 

8. Notwithstanding the foregoing, NECS IS NOT LIABLE TO LICENSEE FOR ANY DAMAGES, INCLUDING
COMPENSATORY, SPECIAL, INCIDENTAL, EXEMPLARY, PUNITIVE, OR CONSEQUENTIAL DAMAGES,
CONNECTED WITH OR RESULTING FROM THIS LICENSE AGREEMENT OR LICENSEE'S USE OF THIS
SOFTWARE. 

9. Licensee agrees to defend and indemnify NECS and hold NECS harmless from all claims, losses, damages,
complaints, or expenses connected with or resulting from Licensee's business operations. 

10. Refund Policy. We have a no refund policy on the Software and related software modules. We do this
because we offer free, fully functional demonstration versions which allow you to use the Software before
your decision to purchase. These demonstration versions allow you to trial test the Software risk-free. Also
our software is provided without any copy restrictions, meaning that once it is installed, NECS has no
means to ensure it is no longer being used. 

11. Governing law. This License Agreement is governed by the law of the State of Connecticut applicable to
Connecticut contracts. 

This document covers system features of entrée V4 SQL. No part of this document may be reproduced in any form or
by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage
and retrieval systems - without the written permission of NECS, Inc. 

Updated September 2016

© 2013 NECS, Inc. All Rights Reserved.
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Legal Notices

Information in this document is subject to change without notice. Complying with all applicable copyright laws
is the responsibility of the end user. Without limiting the rights under copyright, no part of this document may
be reproduced without the express written consent of NECS, Inc.

entrée and NECS Food Distributing System are trademarks of NECS, Inc. in the United States and/or other
countries. NECS, Inc. may have patents, patent applications, trademarks, or copyrights covering subject
matter in this document. Except as expressly provided in any written license agreement from NECS, the
furnishing of this document does not give you any license to these patents, trademarks, or copyrights. 

Microsoft, Windows, Windows NT, Windows 2000, Windows ME, Windows XP, Windows 7, Windows 8,
Windows Vista and Internet Explorer are either registered trademarks or trademarks of the Microsoft
Corporation in the United States and/or other countries.

Intuit and QuickBooks are trademarks and service marks of Intuit Inc., registered in the United States and

other countries.

©2010 - 2018  All Rights Reserved.

Please visit our website at www.necs.com to learn about our other add-on modules, products and services.
Contact our NECS Sales Department at 800.766.6327 or email sales@necs.com for more information. 

NECS, Inc. 322 East Main Street 3rd Floor Branford, CT 06405

Office Hours: Monday - Friday from 8:30AM EST - 5:30PM EST

Toll Free: 800.766.6327 (NECS) 

https://necs.com/index.php
mailto:sales@necs.com
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3 entrée.QB Introduction

Link entrée to QuickBooks and Complete Your Accounting Connection

entrée.QB is an add-on module that allows distributors to port GL (General Ledger) and AP (Accounts
Payable) related data from the entrée application into QuickBooks. The unique design of entrée.QB as a
stand-alone application allows all of the users in the entrée system to work as normal, without any of the
security, network or licensing issues that can occur with a direct link into the QuickBooks application.

Tasks Performed with entrée.QB
§ Post pending AR Journal Entries from entrée into QuickBooks selectively or as a single batch. 

§ Post pending Purchase Order Payables from entrée into QuickBooks selectively or as a single batch. 

§ Allow for synchronization of the entrée and QuickBooks vendor files.

§ Allow for synchronization of the entrée and QuickBooks GL account files.

Operating entrée.QB
§ Operators of the entrée.QB application will typically be the same person or people that would be

responsible for operating QuickBooks on a day to day basis.

§ entrée.QB must be installed on a workstation that has both the entrée application and QuickBooks
Client installed. 

§ In order for entrée.QB to communicate with QuickBooks, QuickBooks must be running and the
QuickBooks company file to post to must be open.

If you would like more information related to pricing or a specific quote for your company’s needs, please
contact the NECS Sales by email sales@necs.com or call 800.766.6327 (NECS). Please visit our website at
necs.com to learn about our other add-on modules, products and services.

http://necs.com/qb/
http://necs.com/index.php
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4 entrée.QB Product Features
The NECS entrée.QB software allows you to easily link your entrée system with QuickBooks*. This module
is especially valuable if your company’s accounting staff is trained and proficient in QuickBooks*, and you want
to continue to use it for General Ledger and Accounts Payable purposes. No longer will there be any kind of
double entry needed, as entrée.QB automates the communications between both systems. 

The unique design of entrée.QB as a stand-alone application allows all of the users in the entrée system to
work as normal, without any of the security, network or licensing issues that can occur with a direct link into
the QuickBooks application. 

General Ledger Features 
· Can optionally import your QuickBooks* Chart of Accounts into entrée V3 or entrée V4 SQL.
· Can optionally export your entrée Chart of Accounts into QuickBooks*.
· Using customer grouping, can release entrée accounting data into different QuickBooks* companies.
· Released data into QuickBooks* can be in a “Summary” format (one entry per general ledger account).
· Released data into QuickBooks* can be in a “Detail” format (each sales and cash receipt transaction posted

as a separate journal entry). 

Accounts Payable Features 
· Link entrée vendors to QuickBooks* vendors.
· Can optionally import your QuickBooks* vendors into entrée. 
· Can optionally export your entrée vendors into QuickBooks*.
· Create a “QuickBooks* Bill” from an entrée received purchase order. 
 

Import / Export & Synchronize GL Accounts 
The entrée.QB software module will synchronize GL (General Ledger) Accounts between entrée and
QuickBooks to ensure the  accuracy of your Chart of Accounts. Typically GL accounts are pulled into entrée
from QuickBooks using the Import GL Accounts utility. However as part of the initial setup of entrée.QB,
operators are allowed to export an existing entrée GL account file into QuickBooks. 
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Override Accounts
Chart of Account codes which override the normal codes can be assigned to your inventory items and your
vendors in the entrée system. To ensure that both entrée and QuickBooks function together properly, you will
need to verify these codes when you first start using entrée.QB.

· Inventory items can be assigned override Sales and Cost of Goods Sold GL accounts defined on the
Cost/Price tab of Inventory File Maintenance in entrée.

·  Click the Search button to open the GL Account Search dialog to find the correct account.

Vendors
Vendors can be assigned override defaults using Def Expense Account and/or Def Control Account fields in the
Vendor tab GL/Account tab in Vendor File Maintenance in entrée.

These expense and control
accounts will be used by
default when creating a
payable to export into
QuickBooks after closing a
purchase order in entrée. 
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Import / Export & Synchronize Vendors
Your entrée vendors must be linked or exported into QuickBooks before any purchase order payables can be
posted into QuickBooks. Typically vendor accounts in entrée are linked into the corresponding vendor
accounts in QuickBooks using the Link Vendors utility. 

As part of the initial setup of entrée.QB, operators are allowed to export any vendors in entrée into
QuickBooks or import QuickBooks vendors into entrée. 
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Post Payables to QuickBooks
entrée offers the ability to create a payable or vendor bill at the time a purchase order is received in the entrée
system. After receiving product from a purchase order and you have received the vendors invoice, you will be
prompted to close the purchase order and create a payable in QuickBooks. 

The Balance To Distribute field will contain the remaining amount of the payable that needs to be distributed.
This value cannot be edited directly, but is derived using the value in the Amount field less the total of the
distributions that have been applied in the distribution grid. 

This field will be highlight in green when the balance reaches 0.00, otherwise it will be highlighted in red. By
default the total of the purchase order (or the Amount field if manually changed) is posted as a distribution to
the  vendors default expense account. 
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Export Journal Entries
As you use the main entrée application and wish to export your account postings to QuickBooks, you will use
the “Release to GL” feature. This will save all account postings to a holding file. entrée.QB then uses the data
contained in the holding file to push the journal entries into QuickBooks. To use this feature, you must have
first synchronized the entrée and QuickBooks GL account files using the Import and/or Export GL Accounts
utility. 

entrée.QB allows for journal entries to be posted into QuickBooks in one of two methods: 
· Summary mode will post an entire entrée release batch as a single journal entry. 

· Detail mode will post a journal entry for each Sales transaction (invoice/credit memo) and cash receipt
within the entrée release batch. 

The detailed posting provides much greater traceability in the QuickBooks general ledger. Sometimes food
distributors using QuickBooks will have more than one company defined. entrée.QB allows you to export
journal entries to different companies you may have defined in QuickBooks.

In order to accomplish this, you can classify
customers into different QuickBooks
companies by using the “Customer Misc.
Code” in Customer File Maintenance in the
main entrée system. 

When exporting journal entries, specify
the QuickBooks company and also the
Customer Misc. Code, and only the
journal entries that are associated with
that customer code will be posted. 
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5 System Requirements

The entrée.QB add-on module requires:
· entrée V3 or entrée V4 SQL.

· QuickBooks desktop versions 2002 or later. 

§ entrée.QB for entrée V3 and entrée V4 SQL has been updated to be compatible with QuickBooks
version 2013 and higher for the Professional, Premier, and Enterprise Editions.

The entrée.QB software must be installed on a workstation that has both the entrée application and the
QuickBooks Client installed. The unique design of entrée.QB as a stand-alone application allows all of the
users in the entrée system to work as normal, without any of the security, network or licensing issues that
can occur with a direct link into the QuickBooks application.

Minimum hardware requirements for entrée version 4 SQL
To improve system performance for larger installations, a faster processor as well as a going to Quad Core
technology on the server is recommended. Workstation performance can be increased by a faster processor
and more RAM memory.

Server Requirements
· Windows 2008 Server / Windows 2012 Server (including Standard and Server Essentials).

· Dual Core processor. Note that the Sybase Advantage Database Server supports multiple processors on
Windows. It is multi-threaded and will perform each user request database operation concurrently or in
parallel if multiple processors are present.

· Intel Xeon 2.4 GHz or greater

· 16GB RAM

· Windows 64-Bit

· 500GB hard drive, 1TB recommended. 3TB recommended if using entrée.DOC, entrée.PEN and have a
high volume of invoice, etc. images that are stored (more than 1,000 images/day to provide sufficient space
for at least 7 years). 

Workstation Requirements
· Windows 7 / Windows 8
· Intel 15 or greater
· 4GB RAM
· 1360 x 768 minimum monitor resolution
· 60GB hard drive

Remote Desktop requirements
Minimum Terminal Server requirements (for up to 10 workstations):

· Dual core Xeon processor 2.2GHz +
· 4 GB Ram
· Windows 2003 Server R2

Recommended Terminal Server requirements (for up to 10 workstations):

· Quad core Xeon processor 2.33GHz +
· 8 GB Ram
· Windows 2008 Server 64 Bit

 The entrée data files should not be installed on the terminal server. Instead they should live on a
separate file server.

http://necs.com/entree_food_distribution_software/


Chapter 6

  QB  

Getting Started



entrée.QB System Guide18

6 Getting Started

entrée Versions
With the release of entrée version 4 SQL in 2014 and the major differences between the menus
and screens in both entrée versions 3 and 4 we have included instructions for using both versions
of entrée in this guide.
 

To differentiate topics for each major version of entrée you will see color coded entrée V3 or
entrée V4 SQL headers in the impacted topics to direct you to the correct information for your
system.

NECS entrée KnowledgeBase Links

· entrée V4 SQL KnowledgeBase

· entrée V3 KnowledgeBase

 To install entrée.QB for the first time use the instructions in the Installing
entrée.QB chapter in this guide.

entrée.QB Online Support & Version Updates
When you are notified that the entrée.QB software has been updated to obtain the new version release you

must login to our website to download it.
1. Go to necs.com and click the Support menu and select Customer Login. Enter your assigned Username

and Password and access the support web page. 

About The Customer Support Web Page
Once logged into the Customer Support web page you can select any software product from the Products
menu on the left to view the current software updates. 

http://www.necs.com/eV4SQL_KB/
http://www.necs.com/knowledgebase/
http://necs.com/
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You can view the entrée.QB user guide, knowledgebases and other support documents for entrée products in
the Customer Support web page. 

In the lower left corner click of the Customer Support web page you can click the Download and review the
NECS 2014 Software Maintenance Agreement to review the latest terms and prices.

2. Select entrée.QB in the Products menu on the left. This will open the page with the latest entrée.QB
software for download. This web page will be used to update your initial installation of the software when new
versions are released

About Release Notes
The Release Notes column contains the README.TXT link. Click the link to review the updates and
modifications that are included in the current software version.

3. Click the green down arrow to download the entrée.QB software version update to your computer. 

4. Then double-click the downloaded software module and run the update process.
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6.1 Installing entrée.QB

Notes of caution before you begin the entrée.QB installation process: 

· entrée.QB must be installed on a workstation that already has a working copy of entrée installed and
configured on it. The data path settings setup and maintained by entrée are shared by entrée.QB.
This point is critical and failure to adhere to it will result in an error message being displayed when
attempting to start entrée.QB.

· QuickBooks software should already be on the computer that entrée.QB will be installed on.

· Before installing and using entrée.QB, please be sure that the numbers from the "Release to GL" in
entrée are in balance.  

· entrée.QB should not be run until all the configuration changes in this chapter have been
implemented. 

 QB-specific configuration changes are system-level changes that will only need to be done
once for any given installation of entrée. (A possible exception would be the changes to a given user's
entrée User Account.) So if you are installing entrée.QB on a second computer everything may already be
configured in entrée to run entrée.QB immediately.

 It is recommended that you begin using entrée.QB at the start of a new period.

Follow these steps to install the entrée.QB add-on module the first time.  
1. Insert your entrée.QB CD into your computer CD drive. 

2. The entrée.QB Installation wizard will begin.

  If the entrée.QB Installation wizard does not run automatically follow these steps:

§ Go to the Windows toolbar at the bottom of your computer screen click on Start > My Computer

§ Find the CD drive containing the entrée.QB install disk. 

§ Double click the CD drive to view the files on the CD.

§ Find the Setup.exe file and double click it to begin the entrée.QB Installation wizard.
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3. The Welcome dialog box will display, click Next.

4. The Warranty dialog box will display, click Yes to accept the terms.
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5. The Choose Destination Location dialog box will display. 
6. To install entrée.QB in the default folder click Next. Or you can click Browse to select a different

location. 

  NECS recommends that you choose the default folder location.

7. The Select Program Manager Group dialog box will display. 
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8. To put an icon on your desktop, check the
box for Add “entrée.QB” icon to desktop.

9. To select the default group click Next or select a group from the list.       
10.  The Start Installation dialog box will display click Next.

11.  Once installation has begun the Installing progress box will display.
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12. When the installation is done the Installation Complete dialog box will display. Click Finish. 

 

13. Now continue to the next section of this chapter Setting up QuickBooks for entrée. 

All the sections in this chapter must be completed to ensure that entrée and QuickBooks are ready for
the synchronization process to follow.



Getting Started 25

6.2 Setting up QuickBooks for entrée
GL Accounts must use account numbers to be compatible with entrée.

1. Start your QuickBooks application and open the company file that will be interfacing with entrée.

2. From the main menu select Edit > Preferences 

3. In the menu bar on the left, select Accounting 

4. Select the Company Preferences tab at the top of the dialog

5. Make sure you check "Use account numbers".

6. Make sure you check "Require accounts".

7. Click OK.  

 The process above will have to be done for every QuickBooks company file that
entrée will be interfacing with.
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6.3 Setting up entrée for QuickBooks
This section will provide an overview of what needs to be configured in entrée version 3 or entrée version 4
SQL, prior to running entrée.QB for the first time.

   Before beginning this update process all users must exit the entrée system
so these steps can be completed.

First Update the entrée Accounting System 
1. Login to your entrée system and do the steps for your version:  

entrée V3 use menu path:  System > Preferences > General Tab.

entrée V4 SQL Go to the System ribbon menu > System Preferences > General Tab.

2. Go to the Accounting System section in the System Version drop down menu select Linked
Accounting.

entrée V3 use menu path:  System > Preferences > General Tab
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entrée V4 SQL Go to the System ribbon menu > System Preferences > General Tab

3. Click OK to save the new accounting system. Now the “File Moved” message box may display saying
that the Vendor file has been relocated to the proper directory. Click OK.

4. You will then see the “Path Information Changed” message box noting that the data paths have  been
changed. Click OK.  

5. Restart your entrée system. 

  After you complete this step users can use the entrée system again.
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Second, Setup Access to entrée.QB for User Accounts
All users of the entrée.QB application must be granted access in their entrée user account. If one or more of
the operators of entrée.QB does not already have an user account in entrée, you will need to create one for
them now.

 Detailed instructions on how to create entrée user accounts can be found in the entrée
KnowledgeBases using the links found in the Getting Started chapter. 

Perform the following steps for only users that will be authorized to use the entrée.QB
application.

1. Open the Security Management utility in entrée use menu path:

entrée V3 use menu path: System > Security Management  

entrée V4 SQL  Go to the System ribbon menu > 

2. Select the entrée user to grant access to and click Edit. This will open the user account properties dialog.

3. Click Settings. 

entrée V3

4. Go to the Miscellaneous
system options list.

5. Click the box and check #86
"Allow use of the entrée
Account Linker application”
option.

6. Click OK.

7. Process the rest of the user
accounts that require this
access following the steps
here.

8. When done click Exit to close
Security Management.  
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entrée V4 SQL

4. Select either the Ribbon or
Legacy layout view.

5.   Go to the Miscellaneous
system options list.

6. Click the box and check #86
"Allow use of the entrée
Account Linker application”
option.

7. Click OK.

8. Process the rest of the user
accounts that require this
access following the steps
here.

9. When done click Exit to close
Security Management. 

What's Next 
The next part of the installation process for entrée.QB is detailed in the First Run chapter. This chapter will
explain the processes required for you to set up access to both systems, and synchronize your entrée and
QuickBooks applications and files. Most of these steps will only have to be done for the first time you run the
application. There is information provided so you can maintain your data going forward. During this process you
will be verifying the data and resolving any errors you encounter. This process will involve fixing account number
conversion errors, adding or removing accounts in one system or the other etc… These are the steps in the
next phase: 

1. Add Application Access

2. GL Account Synchronization

3. GL Department Account Number Conversion

4. Verification of the Chart of Accounts in entrée 

5. Verification of entrée Inventory Cost / Price

6. Verification of entrée Vendor Accounts

7. Vendor Account Synchronization
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7 Your First Run of entrée.QB

7.1 QuickBooks Application Access
The first time you run entrée.QB you will need to authorize the application in QuickBooks. This is a security
measure enforced by QuickBooks to prevent other applications from accessing or modifying sensitive
accounting data without your consent.

How to Add Application Access 
1. Start QuickBooks.

2. Open the company file in QuickBooks
that you wish to post entrée data into.

3. Start the entrée.QB application.

4. At the login screen, enter your entrée username and password.

5. The QuickBooks Application with No Certificate dialog box will display. Because the application is
attempting to access the open company file without a certificate. It is strongly recommended that you
select "Yes, whenever this QB company file is open". 

You can however, choose "Yes, prompt each time", but it is not recommended as the operator will have
to do this step for each QuickBooks session when entrée.QB accesses the company file for the first time.

6.  Once you have selected the access type, click Continue.
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7.  The Confirm to Proceed dialog box will display to confirm your selection, click Yes.

8.  Then the Access Confirmation dialog box will display click Done.

9.  Finally, you should receive a message from entrée.QB that the connection to QuickBooks has been
established. Click OK.

  If you are posting into more than one QuickBooks company, you will need to do the following

for each additional QuickBooks company that you will be posting to:

· Close entrée.QB.
· Close the open company file in QuickBooks.
· Repeat the above procedures, beginning at step 2. 
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How To View / Remove Application Access 
When you need to view or remove applications that have access to the open QuickBooks company file
following these steps: 

1. From the QuickBooks main menu select Edit > Preferences. 

2. In the menu bar on the left, select Integrated Applications.

3. Select the Company Preferences tab at the top of the dialog.
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7.2 GL Account Synchronization
This section will outline how to synchronize GL Accounts between entrée and QuickBooks. Typically GL
accounts are pulled into entrée from QuickBooks using the Import GL Accounts utility. However as part of the
initial setup of entrée.QB, operators are allowed to export an existing entrée GL account file into
QuickBooks. 

Importing GL Accounts 
Internally, entrée has a GL Accounts file that is used mostly for system GL account searches. The data
contained in this look up file, is imported directly from the QuickBooks system using the Import GL Accounts
utility.

 Your QuickBooks GL Accounts must be imported into entrée before any payables or AR journal
entries can be posted into QuickBooks.

    

Grid Column Description

Import? This column indicates if the account data will be imported from QuickBooks.

Account # The numeric ID used as an identifier for the GL account.

Account Name Descriptive name for the GL account. Must be 30 characters or less

Account Type The type of account as defined in QuickBooks.

Description The account description (assigned in QuickBooks).

External ID The internal ID assigned to the GL account by QuickBooks. entrée.QB requires
this code to ensure the account is a valid QuickBooks GL account.

Active?   Indicates if the account is available to post into.

Parent Account When using departments or sub-accounts, this column will contain the name of the
parent GL account.
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How to Use the Import GL Account Utility  
1. In entrée.QB use menu path: File > GL Accounts > Import

2. Select the accounts you want to import into entrée, (all are selected by default).

· Accounts that should be imported will need to be checked in the "Import?" column.
· The checked state of an account can be toggled by…

§ Double clicking the line with the account to import in the grid.
§ Pressing the "Enter" or "Space" key will toggle the selected row. 
§ All accounts will be checked by clicking the "Select All" button.
§ All accounts will be unchecked by clicking the "Select None" button.

3. Once the accounts to import have been selected, click Import.

4.   You may be presented with a Confirm dialog box with a warning that new accounts will be created in
entrée. This is just an informational message. 

5.   Click OK to continue.

· During the import process, the account grid will be hidden and replaced with a message stating “Importing
data…Please wait”.

· You will also notice a progress indicator in the lower left corner of the entrée.QB application window.

6. Upon completion the Export Status dialog box will display the number of accounts that were imported into
entrée.
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7.3 Exporting GL Accounts from entrée
If you are a distributor that has been using the entrée.AP and entrée.GL add-on modules and are moving to
QuickBooks, and have not setup a chart of accounts in QuickBooks yet, you can export the GL accounts that
were used in entrée directly into QuickBooks.

 

Grid Column Description Can Edit

Export? This column indicates if the account data will  be exported into
QuickBooks.    þ

Account # The numeric ID that was used as an identifier for the GL account in entrée.

New Acct # The account number that will  be used when the account is created in
QuickBooks.   þ

Account Name Descriptive name for the GL account that was used in entrée.

New Acct Name The descriptive name for the account that will  be used in QuickBooks. This
mustbe 30 characters or less.  þ

Balance The current account balance of the entrée GL account. This will  be the
starting balance of the new QuickBooks account.

Account Type The QuickBooks account type that should be assigned to the entrée
account. þ

Active? Indicates if the account is available to post into.

Parent Account When using departments or sub-accounts, this column will  contain the
name of the parent GL account.
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How to Use the Export GL Accounts Utility  
1. In entrée.QB use menu path: File > GL Accounts > Export

2. When the Export GL Accounts utility is first opened, you will be prompted to select the entrée GL
account file (GLACNTxx) that you wish to export into QuickBooks. 

As part of the export process, all accounts that are exported are automatically imported for use in entrée
as part of the process, so you will not need to run an import operation after exporting accounts.

3. Navigate to the directory that contains the entrée GL account file,
 
4. Click Open. 

5. entrée.QB will then start loading the GL accounts into the account grid.

· This process may take a little time, so a progress indicator will be displayed in the lower left corner of the
entrée.QB application window.

 If you select the wrong file or wish to start over click the Refresh button to reopen the "Select GL
Account file to export dialog.
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7.4 GL Department Account Number Conversion
If you were using GL Departments in the entrée accounting system, all of the existing GL account numbers
will have to be reassigned. This is because entrée GL account numbers when departments are enabled are 9
characters in length (#####-###). QuickBooks will only support account numbers up to 7 characters in length.
To help compensate for this during your company transition entrée.QB will attempt to convert your existing
account numbers into a 7 character format using one of several options detailed below.  

When departments are detected when exporting entrée GL accounts you will be prompted for the
desired conversion method. 

1. Select the desired method by clicking the arrow to view the drop down menu.

 

Conversion Method Description

Drop the last character of the department The dash character and the last character of the department number
will  be removed from the account number.

Drop the first character of the department The dash character and the first character of the department number
will  be removed from the account number.

Drop the last character of the account The dash character and the last character of the account number will
be removed from the account number.

Re-sequence departments using (2) digits   The dash character will  be removed from the account. Departments
will  be reassigned using two digits starting with "01".

Re-sequence departments using a dash and
(1) digit Selected by default

 This is the only automated option where the dash  character is 
retained. Departments will  be reassigned using a single digit starting
with "1".       

Manual All  new account numbers will  have to be manually entered.

2.  Select the accounts that you wish to export into QuickBooks, (all valid accounts are  
    selected by default).

· Accounts that should be exported will need to be checked in the "Export?" column.
· The checked state of an account can be toggled by…

§ Double clicking the line with the account to export in the grid.
§ Pressing the "Enter" or "Space" key will toggle the selected row.
§ All accounts will be checked by clicking the "Select All" button.
§ All accounts will be unchecked by clicking the "Select None" button.
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3. Once the accounts to export have been selected, click Export. 

4. You will be prompted with a confirmation dialog indicating the QuickBooks company file that you are about
to exchange data with. 

5. Click Yes to proceed with the export operation

· During the import process, the account grid will be hidden and replaced with a message stating "Importing
data…Please wait".

· You will also notice a progress indicator in the lower left corner of the entrée.QB application window.

6. Upon completion the Export Status dialog box will display the number of accounts that were exported.
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7.5 Verification of Chart of Accounts
After GL accounts have been imported or exported you should verify the chart of accounts in entrée. You will
update accounts as needed with any new account numbers that may have been created during the
conversion. 

· You may find that some accounts no longer have a description in the GL Description column. This is typical
if an account number had to be changed when exporting GL accounts. 

· Each account you intend to utilize during the AR release process must have both an account number and a
GL Description assigned.

§ To edit an assigned account, double click the desired account or press the Enter key to edit the
selected account. 

§ Double-click the grid line and the Search button  will display or hit the F5 key to invoke the
GL Account search screen.

§ If you are using Customer GL Link codes, those should be verified or edited as well.

· Once the verification of accounts has been completed click OK.

 For additional information about the GL Accounts tab use the entrée KnowledgeBase links
found in the Getting Started chapter. 

entrée V3 Use menu path: System > Preferences > GL Accounts tab to access and update these
accounts. 
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entrée V4 SQL Go to the System ribbon menu > System Preferences > GL Accounts tab.
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7.6 Verification of entrée Inventory Cost / Price
If there are any items that have been assigned override Sales and Cost of Goods Sold GL accounts, those will
need to be verified as well. This is done on the Cost/Price tab of Inventory File Maintenance. 

· Blank values in these accounts indicate they will use the “Sales Account 1” and the “Cost of Sales 1”
accounts as defined on the GL Tab in System Preferences.

· Use the Search Tool   to find the specific accounts for the item if needed.

· Once changes are made click Apply then OK.

 For additional information about the Cost/Price tab use the entrée KnowledgeBase links
found in the Getting Started chapter.
 
entrée V3 Use menu path: File > Inventory Maintenance  > locate the item > click the Cost/Price Tab  >
G/L Cost of Sales Account and G/L Sales Account.
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entrée V4 SQL Go to the Inventory ribbon menu > Inventory > locate the item > Cost/Price Tab > G/L
Cost of Sales Account and G/L Sales Account.
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7.7 Verification of entrée Vendor Accounts
You will need to review and verify any vendors that have been assigned a default Def Expense account and/or
default Def Control account. This is done on the Vendor tab of Vendor Maintenance. 

· A blank value in the Default Control Account field will instruct the system, to use the first “Accounts
Payable” account that is being used in QuickBooks (the one with the lowest account number). 

· These accounts will be used by default when creating a payable to export into QuickBooks after closing a
purchase order in entrée.

· Use the Search Tool   to find the specific accounts for the vendor if needed.

· Once changes are made click Apply then OK.

 For additional information about the Vendor tab use the entrée KnowledgeBase links found
in the Getting Started chapter. 

entrée V3 Use menu path: File > Vendor Maintenance  > locate the vendor > click the Vendor Tab >
Accounting Defaults section > Def Exp Acct and Def Ctrl Acct.
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entrée V4 SQL Go to the Vendor ribbon menu > Vendors > locate the vendor > click the Vendor Tab > go
to the GL Account sub-tab > Def Exp Acct and Def Ctrl Acct.



entrée.QB System Guide46

7.8 Vendor Account Synchronization
This section will outline how to synchronize vendors between entrée and QuickBooks. Typically vendor
accounts in entrée are linked into the corresponding vendor accounts in QuickBooks using the Link Vendors
utility. However as part of the initial setup of entrée.QB, operators are allowed to export any vendors in entrée
into QuickBooks or import QuickBooks vendors into entrée. 

For additional information about Vendors see the Vendor File Maintenance in your entrée System Guide.

Linking Vendor Accounts
For most installations entrée and QuickBooks each have a vendor file, which is being maintained separately
within each system. The Link Vendors utility will import and store the internal QuickBooks vendor ID directly
within the existing entrée vendor file. 

Once your vendors have been linked together, for ongoing maintenance of Vendor accounts you have two
options:

· Import Vendors utility, which will refresh the entrée vendor file with data from QuickBooks.

· Export Vendors utility which will refresh the Vendor name and address properties within QuickBooks
with the export data from entrée.
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 Your entrée vendors must be linked or exported into QuickBooks before any purchase order

payables can be posted into QuickBooks.

Grid Column Description Can Edit

entrée ID This column will  display the vendor ID as defined in entrée.

Company This column will  display the vendor's company name as defined in entree. 

External Company This column will  display the vendor's company name as defined in
QuickBooks.

External ID The internal ID assigned to the vendor by QuickBooks. entrée.QB requires this
code to l ink the entrée vendor to the QuickBooks vendor

þ

Using the Link Vendors Utility
To run the Link Vendors Utility in entrée.QB use menu path: File > Vendors > Link

It is recommended the first time that you use the Link Vendors utility that you take advantage of the Auto Link
feature, by clicking the Auto Link button in the lower right corner of the Link Vendors utility. Auto Link works by
attempting to match the entrée and QuickBooks vendor company names. If a successful match is found, the
vendors will be linked automatically.

Once this process finishes, the Complete dialog
box will display how many vendors were able to be
linked automatically. 

Manually Linking Vendor Accounts
Manual linking can be used to link a vendor that was not able to be linked with the Auto Link feature. If the
External Company & ID field already contains a value then the vendor is already linked.

1. Select the entrée vendor that you wish to link to a QuickBooks vendor and press the Enter key. This will
place the cursor in the External ID field for the selected vendor.

2. Click the Search button to the right of the External ID field or press the F5 key to open the Vendor
Search screen. This screen will contain all of the vendors that currently exist in QuickBooks.

The Vendor Search screen allows you to search for a QuickBooks vendor by any of the columns in the
search grid except for "Active". To change the field to search on you can click the column heading or
select the column from the drop down list on the left of the search header.

3. Once the desired vendor is selected, press the OK to return to the Link Vendors utility. The vendor will now
be linked and the External Company and External ID fields will contain the correct values from
QuickBooks based on the selected vendor.
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Vendor Accounts Maintenance

· Removing an Existing Vendor Account 
You may run into an issue where the wrong QuickBooks vendor got linked to an entrée vendor. Removing the
link between the two vendors is a simple process. 

1. Select the entrée vendor that you wish to remove the link to and press the Enter key.

2. Clear the current value from the External ID field.

3. You will then be prompted for confirmation.

4. Click Yes to disassociate the entrée vendor for the QuickBooks vendor. 

Exporting Vendor Accounts
If you are setting up a new QuickBooks company file, you will want to export your existing entrée vendors into
QuickBooks. This will allow for the creation of payables from an entrée purchase order. 

You may occasionally want to refresh the vendor name and address data in QuickBooks from the data
contained in the entrée vendor file. Both of these operations are performed with the Export Vendors utility.
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Grid Column Description

Export?  Place a check in this field if the entrée vendor should be exported into QuickBooks.

entrée ID  This column will  display the vendor ID as defined in entrée.

Company This column will  display the vendor's company name as defined in entree. 

External Acct # This column will  display the vendor ID as defined in QuickBooks. Typically this is the
same as the entrée vendor ID

External Company This column will  display the vendor's company name as defined in QuickBooks. 
Typically this is the same as the entrée vendor company name.

· Using the Export Vendors Utility
1. To run the Export Vendors Utility in entrée.QB use menu path: File > Vendors > Export

2. Select the vendors that you wish to export into QuickBooks, (all valid vendors are selected by default). 

· Vendors that should be exported will need to be checked in the "Export?" column.
· The checked state of a vendor can be toggled by…

§ Double clicking the line with the vendor to export in the grid.
§ Pressing the "Enter" or "Space" key will toggle the selected row.
§ All vendors will be checked by clicking the "Select All" button.
§ All vendors will be unchecked by clicking the "Select None" button.

3. If you are creating a new vendor, a vendor with the same company name as the entrée vendor cannot
already exist in QuickBooks. If entrée.QB detects that a vendor exists in QuickBooks with the same
company name as the vendor you are trying to create, you will be presented with the Invalid Selection error
dialog indicating that these vendors should be linked.

4. Once the vendors to export have been selected, click Export.
   
5. A Confirm dialog box will display a message indicating the QuickBooks company file that you are about to

exchange data with. 

6. Click Yes to continue with the export.
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7. If you are creating new
vendors in QuickBooks, a
second Confirm dialog
box will display with a
warning indicating that
new vendors will be
created in QuickBooks. 

    This is just an
informational message.

8. Click OK to continue.

9.   During the export process, the vendor grid will be hidden and replaced with a message stating “Exporting
data…Please wait”.

      
· You will also notice a progress indicator in the lower left corner of the entrée.QB application window.

10. Upon completion, the Export Status
dialog box will display the number of
vendors that were exported.
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Importing Vendor Accounts
If you have vendors that are setup in QuickBooks that do not exist in entrée, and you want to use to generate
payables or bills for those vendors from an entrée purchase order, you will need to first import them into
entrée using the Import Vendors utility. 

You can also import vendor company address and balance data from QuickBooks into the entrée data files for
vendors that have already been exported or linked using entrée.QB.

Grid Column Description

Import? Place a check in this field if the QuickBooks vendor should be exported into entrée.

External Acct # This column will  display the vendor ID as defined in QuickBooks. Typically this is the
same  as the entrée vendor ID. 

External Company This column will  display the vendor's company name as defined in QuickBooks. 
Typically this is the same as the entrée vendor company name.

entrée ID This column will  display the vendor ID as defined in entrée.

Company This column will  display the vendor's company name as defined in entree. 

· Using the Import Vendors Utility
1. To run the Import Vendors Utility in entrée.QB use menu path: File > Vendors > Import

2. Select the vendors that you wish to import into QuickBooks, (all valid vendors are selected by default).
 
· Vendors that should be imported will need to be checked in the "Import?" column.
· The checked state of a vendor can be toggled by…

§ Double clicking the line with the vendor to import in the grid.
§ Pressing the "Enter" or "Space" key will toggle the selected row.
§ All vendors will be checked by clicking the "Select All" button.
§ All vendors will be unchecked by clicking the "Select None" button.
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3. If you are creating new vendors in entrée, the vendor in QuickBooks, must have an account number
defined. 

· If a vendor does not have an account number when attempting to create the vendor in entrée, the Import
Error dialog box will display. Click the Retry button to complete the import of any remaining vendors.

· Then, go back into QuickBooks and assign account numbers to the vendor(s) that produced the error
message. 

· Once account number assignment is completed, you will be able to import them into entrée.

4. Once the vendors to export have been selected, click Import.

5. If you are creating new vendors
in entrée, a Confirm dialog
box will display. 

A warning will say new vendors
will be created in entrée. This
is just an informational
message.

6. Click OK to continue. 

7. During the import process, the vendor grid will be hidden and replaced with a message stating “Importing
data…Please wait”. You will also notice a progress indicator in the lower left corner of the entrée.QB
application window. 

8. Upon completion, the Export
Status dialog box will display
the number of vendors that were
imported.
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8 Payables Introduction
This chapter will outline how to export a payable or QuickBooks bills that were created in entrée after closing
a purchase order. 

To use this feature, you must have completed these steps:

1. Synchronization and verification of the entrée and QuickBooks vendor files using the Link Vendors, Export
Vendors and / or Import Vendors utilities.

2. Synchronization and verification of the entrée and QuickBooks GL account files using the Import GL
Accounts and / or Export GL Accounts utilities.

8.1 Creating a Payable in entrée
entrée version 3 and V4 SQL offer the ability to create a payable or vendor bill at the time a purchase order
is received in the entrée system. After receiving product from a purchase order the operator will be prompted
to close the purchase order. The process is the same in either version of entrée.

If Yes is chosen and the purchase order is
closed.

The Question dialog box will open and ask Post
the purchase order to Accounts Payable. 

By selecting Yes the "Post payable to external
accounting" dialog will be displayed.

When the Post payable to external accounting dialog box displays key information will already be
populated using data from the purchase order. 

· The vendor information will be displayed along the top of the dialog and cannot be modified.

· The PO number field, in the Payable section, will also be filled in and is not able to be edited.

· Finally the Amount field will be pre-populated with the purchase order total. This value however can be
edited if required.

Post payable to external accounting screen details
Invoice # - The first thing the operator must provide is the invoice number from the vendor. This is keyed into
the Invoice # field. Once that value is provided, more fields will be initialized, such as the due date, the control
account, and a single distribution to the vendors default expense account.

Invoice Date - Enter the date of the vendors invoice in this field. The date can be selected from the calendar
control by clicking the down arrow of the Invoice Date control or by pressing the down arrow key on the
keyboard when the cursor is in the Invoice Date field.

 When the Invoice Date value is changed, the Due Date will be automatically updated based on
the number of days between the invoice date and the due date.

Due Date - Enter the date that payment should be remitted to the vendor by in this field. The date can be
selected from the calendar control by clicking the down arrow of the Invoice Date control or by pressing the
down arrow key on the keyboard when the cursor is in the Invoice Date field.
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entrée V3 

 

entrée V4 SQL
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Amount - Enter the amount due from the vendor's invoice in this field. By default, it will contain the purchase
order total.

Control Account – Enter the GL Liability account that should be credited for the amount of the vendor's invoice
in the Ctrl Acct field. This field will default to the entrée vendor's default control account. If the control account
is empty, it is because there is no default control account defined for the vendor, and entrée was unable to find
an account that was flagged as an “Accounts Payable” account in QuickBooks. 

 The control account may be changed or added by keying the value directly into the Ctrl Acct field

or using the GL Accounts search screen, which is accessed by clicking the Search button  to the right of
the field or pressing the F5 key while the cursor is in the Ctrl Acct field.

Reference – Up to 20 characters reference or memo may be optionally keyed into this field.
The value entered in this field will appear in the Ref. No. field on the QuickBooks bill.

Balance to Distribute - This field will contain the remaining amount of the payable that needs to be
distributed. This value cannot be edited directly, but is derived using the value in the Amount field less the total
of the distributions that have been applied in the distribution grid. This field will be highlight in green when the
balance reaches 0.00, otherwise it will be highlighted in red.

Distributions

Distributions are one or more offsetting transactions that are debited to a GL asset or expense account, the
total of which offset the amount that was posted to the control account. 

By default the total of the purchase order (or the Amount field if manually changed) is posted as a distribution
to the vendors default expense account.

Changing the amount of a distribution in the grid:
1. By selecting the distribution and then pressing the Enter key. 
2. Enter the desired distribution amount in the Amount field in the distribution grid.
3. Optionally enter a transaction reference into the Reference field of the distribution grid.

Adding a new distribution to the grid:
1. Click Add.
2. The cursor will be placed in the GL Account field of the distribution grid. 
3. Enter the account number for the asset or expense account that should be distributed to. Click the

Search button or pressing the F5 key from within this field to open the GL Accounts search screen.
4. Enter the amount of the distribution in the Amount field in the distribution grid.
5. Optionally enter a transaction reference into the Reference field of the distribution grid.

Removing a distribution from the distribution grid:
1. Select the distribution to remove.
2. Click Delete. 
3. A Confirm dialog box will be displayed.
4. Click Yes.

Saving modifications to distributions in payables: 
1.  Once the total of the distributions matches the total of the vendors invoice, click Post to save the payable.
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Canceling a payable:
1. Click Cancel to discard the payable and the vendors invoice will have to be manually created in

QuickBooks. 
2. entrée will warn the operator upon clicking the Cancel button that the payable will be discarded. 

3. Click the Yes button to proceed with the Cancel operation
4. Click the No button to save the payable in the state that it is in.
5. Click the Cancel button to return to the Post payables to external accounting dialog without saving the

payable. 

8.2 Posting Payables in QuickBooks
When a payable is created in entrée, it is put into a holding file. entrée.QB is then used to push the payable
from the holding file into QuickBooks. This is done with the Export Payables utility. 

  Before payables can be posted into QuickBooks, entrée vendors must be linked to existing
QuickBooks vendors or exported into QuickBooks. Also, GL accounts must be imported from QuickBooks or
exported into QuickBooks from the entrée.GL accounts file.
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Grid Column Description

Export?   Place a check in this field if the payable should be exported into QuickBooks.

Vendor # This column will  display the vendor ID as defined in entrée.

Vendor Name This column will  display the vendor's company name as defined in entrée.

PO # This column will  display the entrée purchase order number associated with the
payable.

Invoice #   This column will  display the vendor's invoice number. 

Inv. Date This column will  display the vendor's invoice date.

Amount This column will  display the total amount due for the payable.

Ctrl Acct  This column will  display the Accounts Payable GL account that will  be credited when
the payable is created.

Reference This column will  display the optional reference that is associated with the payable.

How to Use the Export Payable Utility
1. In the entrée.QB menu using menu path: Post > Payables

2. When the Export Payables utility is first opened, all pending payables are loaded into the payable grid.
Payables are validated when they are first loaded to ensure the Vendors exist in QuickBooks, the control
and distribution GL Accounts are valid, and the distributions are in balance with the payable total. This
process may take a little time so a progress bar is displayed in the lower left corner of the entrée.QB
application window.

 If there are currently no payables
pending to be exported into QuickBooks, a
dialog will be displayed indicating there is
nothing to export and the payable grid will be
empty.

3. Select the payables that you wish to export into QuickBooks, (all are selected by default).

· Payables that should be exported will need to be checked in the "Export?" column.
· The checked state of a payable can be toggled by…

§ Double clicking the line with the payable to export in the grid.
§ Pressing the "Enter" or "Space" key will toggle the selected row.
§ All valid payables will be checked by clicking the "Select All" button.
§ All payables will be unchecked by clicking the "Select None" button.

4. Once the payables to export have been selected, click Export.
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5. A Confirm dialog box will display indicating
the QuickBooks company file that you are
about to exchange data with. 

6. Click the Yes to proceed with the export
operation.

7. During the export process, the payables grid will be hidden and replaced with a message stating
“Exporting data…Please wait”.

8. You will see a progress indicator in the lower left corner of the entrée.QB application window.

9. Upon completion the Export Status dialog box will display the number of payables that were exported.
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9 AR Journal Entries
This chapter will outline how to export AR Journal Entries that were created in entrée using the Release to GL
utility. 

In order to use this feature, you must have first synchronized the entrée and QuickBooks GL account files
using the Import and  /or Export GL Accounts utility in entrée.QB. 

9.1 Posting Journal Entries in QuickBooks
When the entrée Release to GL utility is run, all account postings are saved to a holding file. entrée.QB then
uses the data contained in the holding file to push the journal entries into QuickBooks. 

 For more information on the Release to GL process use the entrée KnowledgeBase links
found in the Getting Started chapter. 

The Journal entry grid is displayed on the left side of the Export Journal Entries utility. This grid displays
information about the journal entry as a whole. If you are posting in Detail mode, this grid will contain additional
columns pertaining to the Sales and Receipt transactions.

The Journal Entry Grid in detail mode displays the miscellaneous code from the Miscellaneous tab in
Customer Maintenance in the main entrée system. 

Journal entries can be selected by a specific Misc Code for batch exporting. This process will be discussed in
more detail in the instructions below. 
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Grid Column Description Mode

Export? Indicates if the journal entry will  be exported into QuickBooks.

Batch Displays the Batch ID assigned by entrée to the journal entry.

Trans Date Displays the journal entry transaction date.

Trans Type Displays the journal entry transaction type (Sales or Receipt). (detail  only)

Invoice # Displays the invoice number associated with a Sales journal entry.     
   (detail  only)

Cust # Display the customer number associated with a Sales or Receipt
journal entry. (detail  only)

Check # Display the check number associated a Receipt journal entry.  (detail  only)

Misc Code Displays the customer's miscellaneous code from the Miscellaneous
tab of Customer Maintenance in entrée.    (detail  only)   

Export Journal Entries Detail Grid
The detail grid is displayed on the right side of the Export Journal Entries utility. This grid displays each of the
GL accounts that will be credited or debited as part of the journal entry. Beneath the Amount column the total
of all accounts is displayed and should always be 0.00, which indicates a journal entry is in balance.
  

Grid Column Description

Account # Displays the GL account number, as defined in QuickBooks.

Account Name  Displays the GL account name, as defined in QuickBooks.

Amount Displays the amount that will  be credited or debited into the GL account

entrée.QB allows for journal entries to be posted into QuickBooks in one of two methods. 

1. Summary mode: will post an entire entrée release batch as a single journal entry. 

2. Detail mode: will post a journal entry for each Sales transaction (invoice/credit memo) and cash receipt
within the entrée release batch. While the detailed posting provides much greater traceability in the
general ledger, it comes at the cost of significantly longer data export times.

· entrée.QB by default will post journal entries using Summary mode.

How to Export Journal Entries 
1. From entrée.QB menu use menu path: Post > Journal Entries

2. To post the full detail, click the Detail button in the top right corner of the Export Journal Entries window.
The detail  loading process may take a little time, so a progress bar is displayed in the lower left corner of
the Export Journal Entries window, while the transaction are loaded.

3. Once detail mode is displayed, you can switch back to summary mode by clicking the Summary button in
the top right corner of the Export Journal Entries window.

4. Whichever method you decide to post journal entries with, it should be the same for every export to provide
proper consistency in the general ledger.
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 If there is currently no pending
journal entries to be exported into QuickBooks, a
dialog will be displayed indicating there is not
anything to export and the journal entry grid will
be empty. Click OK.

5. Select the batches (summary mode) or transactions (detail mode) that you wish to export into
QuickBooks, (all are selected by default).

· In Detail mode to select transactions by Misc Code:
§ Double-click the desired miscellaneous code in the Misc Code column.
§ This will initiate the display of a confirmation dialog box indicating the Misc Code value selected.

§ Click Yes to select only the transactions with that specific customer miscellaneous code.
§ Proceed to step 6 below.

· In Summary mode to select batches/transactions to be exported you need to check the Export?
column. The checked state of a batches/transaction can be toggled by…

§ Double clicking the line with the batch/transaction to export in the Journal Entry grid.
§ Pressing the "Enter" or "Space" key will toggle the selected row.
§ All valid batches/transactions will be checked by clicking the "Select All" button.
§ All batches/transactions will be unchecked by clicking the "Select None" button.

 It is strongly recommended that all transactions in a single batch are exported together as to not
have partial release data in QuickBooks.

6. Once the batches/transactions to export have been selected, click Export.

7. A Confirm dialog box will display indicating the QuickBooks company file that you are about to exchange
data with. Click Yes to proceed with the export operation.
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8. During the export process, the journal entry and the detail grid will be hidden and replaced with a message
stating “Exporting data…Please wait”.

9.  You will also notice a progress indicator in the lower left corner of the entrée.QB application window.

10.  Upon completion the Export Status dialog box will display the number of transactions that were exported. 
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